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Notice: Read this before installing the software.

You agree that the Licensed Software product belongs to us
and you agree to keep confidential and use your best efforts
to prevent and protect the contents of the Licensed Software
Product from unauthorized disclosure.

Carefully read the terms and conditions of this agreement
before opening the product package. Opening the package
indicates your acceptance of these terms and conditions. If
you do not agree with the terms and conditions of this
Agreement, promptly return the package unopened to the
place where you obtained it.

Limited

Definitions
The Software Product is licensed (not sold) to you. The
Software product includes all copies of the Software Product
and its related supporting materials.
License
VEST, Inc. (we, our, us) grants you a personal, nontransferable, and non-exclusive license to use the Software
Product in the specified quantity only.

1. For 90 days from the date of shipment, we warrant that
the media (for example, CD) on which the Licensed
Software Product is contained will be free from defects in
materials and workmanship. The warranty does not
cover damage caused by viruses, improper use or
neglect.
We do not warrant the contents of the Licensed Software
Product (it is furnished "AS IS" and without warranty as
to the performance or results you may obtain by using
the Licensed Software Product) or that it will be error
free.
2. You assume the entire risk as to the results and
performance of the Licensed Software Product.

You may not:
1. distribute, sublicense or copy any portion of the Licensed
Software product:
2. modify or prepare derivative works from the Licensed
Software Product:
3. transmit the Licensed Software product electronically by
any means: or
4. Use the Licensed Software product in multiple computer
or multiple user arrangements unless that use is covered
by individual license for each computer or user.

To get media warranty service during the 90-day
warranty period, you may return the Product (postage
paid) with a description of the problem to the place
where you obtained it. The defective media on which the
Licensed Software Product is contained will be replaced
at no additional charge to you.
3. If you do not receive media that is free from defects in
materials and workmanship during the 90-day warranty
period, you will receive a refund or credit to your account
for the amount you paid for the Licensed Software
Product returned.

Disclaimer of Warranty
YOU UNDERSTAND AND AGREE AS FOLLOWS:
1. Warranties in this agreement replace all other
warranties, express or implied, including any warranties
of merchantability or fitness for a particular purpose. We
disclaim and exclude all other warranties.
2. We will not be liable for any loss or damage caused by
delay in furnishing a Licensed Software Product or any
other performance under this Agreement.
3. Our entire liability and your exclusive remedies for our
liability of any kind (including liability for negligence
except liability for personal injury caused solely by our
negligence) for the Licensed Software Product covered
by the Agreement and all other performance or nonperformance by us under or related to this Agreement
are limited to the remedies specified by this Agreement.
4. In no event will our liability of any kind include any
special incidental or consequential damages, even if we
have knowledge of the potential loss or damage.
5. Special notice to consumers: some states do not allow
the exclusion of implied warranties so the above
exclusion may not apply to you. The warranty gives you
special legal rights, and you may also have other rights,
which vary from state to state.
Termination
This Agreement is effective until terminated. You may
terminate it any time by destroying the Licensed Software
Product. It will also terminate if you do not comply with any
term or condition of this Agreement. You agree upon
termination to destroy the Licensed Software Product.
General
You are responsible for installation, management and
operation of the Licensed Software Product.
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1. Introduction
Welcome to VEST HyDraw ® V700
Create accurate, error free, professionally
drawn hydraulic circuits, parts lists, and
quotations quickly and easily.
Drag-and-drop ‘smart’ symbols into a drawing
with point-and click component selection. The
‘smart’ connection lines snap to ports and
self-route with jumpers.
Auto BOM generation ensures accuracy of
your Bill of Materials. Easily insert it into the
circuit drawing, or export it to Microsoft Excel.
Get started with over 7,000 ISO 1219-1
compliant symbols covering both industrial
and mobile hydraulics. ‘Remember’ your data
and rules using HyDraw’s custom database.
Ensure up-to-date pricing of components by
linking your ERP data to HyDraw.
HyDraw works seamlessly within Microsoft
Visio. Circuit design data can be easily ported
to downstream manifold design and CAM
systems.

HyDraw®V700 drawing area with Ribbon menu, HyDraw Library Explorer, and HyDraw Property Manager

HyDraw can access manufacturer component
data from FluidPowerTools.com, a fee based
service from VEST. Also, submit your circuit
to QuickManifolds.com for ‘instant’ manifold
design.
Use HyDraw and ensure your competitive
edge.

VEST, Inc.
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HyDraw® V700 is easy to use. It works
seamlessly within the Microsoft Office Visio
environment with its own ribbon menu.
HyDraw symbols are located quickly by
navigating logically structured menus. Sets of
related symbols are shown together and any
required symbol can be inserted into the
drawing by the drag and drop method. You
can insert generic symbols or model code
specific component symbols into the library.
Edit parametric properties of the inserted
symbols, when needed.
HyDraw Library
The HyDraw library accommodates a wide
range of simple and complex graphical
component symbols, and schematic
diagrams covering both Industrial and Mobile
Hydraulics. Designed in accordance with
ISO1219-1:2012, Fluid Power Systems and
Components-Graphic Symbols and Circuit
Diagrams-Part 1: Graphic Symbols for
Conventional Use and Data Processing
Applications. A few percentile deviations from
ISO standard necessitated keeping in view
the large variants of symbols and customer
base. The HyDraw library includes both Slipin and Screw-in Cartridge valves and
associated symbols for manifold design
circuits.

Smart Symbols
HyDraw symbols are created using primitive
shapes, such as lines, polylines, rectangles,
squares, circles, circular arcs, ellipsis. They
represent components with specified
functions or method of operation in the deenergized (at rest) position, or component
specific rule that do not have a clearly
defined de-energized position. A pool of ISO
specified primitive shapes are included in the
library to help you design your own generic
symbols. HyDraw symbols also include port
identification and port numbering, which is
essential for manifold design.
ISO guidelines
VEST has adhered to ISO guidelines of
Module System (1Module = 2 Millimeter),
where the symbol fits into a grid and presents
a symmetry. The use of layer properties for
assigning ISO defined color to Supply line,
Return line, Pilot line, Drain line, Envelope
line, and Flow direction exhibits appealing
color graphics, which help in instant
understanding of the operational aspect of
the component. Layer properties are also
utilized for naming ports, positions and
solenoids. (both US and European pattern)

Search
The new and powerful HyDraw V700 Search
command searches general or OEM specific
symbols and circuits from
www.FluidPowerTools.com, saving time and
effort.
Teamwork
HyDraw helps standardization and teamwork.
Multiple users within a local area network can
share a common HyDraw library. This
enhances productivity of the design and
engineering team.
Customization
Customize HyDraw to your specific need
using the library and data management
console. Save custom components data with
symbols tagged to a specific model code and
relevant OEM catalog data.
More…
Dynamic Directional Control (DC) Valve
design and OEM-specific circuit design with
Parts List from component properties held in
the library make the software very productive.
Net List creation, Manifold Cost Estimation
and interface to FluidPowerTools.com and
QuickManifolds.com enable significant cost
and time savings.
Work Smart! Use HyDraw® today.

VEST, Inc.
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2. Support
1

User Manuals
The HyDraw® V700 User Manual provides comprehensive information on the features,
commands, usage, processes, and design methodology of HyDraw.
The user manual can be used as a comprehensive reference to the command set and
usage of HyDraw.
The Contents and Index listing guides you to relevant material for study and reference.

**

2

Click the Help command on the HyDraw V700 ribbon menu to view the user manual in the
Adobe Acrobat .pdf format.

Support
If you have a question about HyDraw V700 email us at support@VESTusa.com.
Please include the following:



Version Number of the software you are using.
To see the version of HyDraw on your machine,
select About HyDraw from the HyDraw ribbon menu in Microsoft Visio.



Configuration of your machine.



Exact messages, if any, on the screen.
Send a screen capture, if possible.



Description of the problem and what you were doing when the problem occurred.



Description of how you tried to solve the problem.

*** Click the About HyDraw command on the HyDraw V700 ribbon menu to view the About
HyDraw message box indicating the software version number, serial number and the
copyright notice.

VEST, Inc.
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Workspace
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HyDraw Startup

4

HyDraw V700 Ribbon Menu

5

HyDraw Library Explorer

6

HyDraw Property Manager

7

HyDraw Options
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3. HyDraw Startup
Note: For HyDraw V700 installation refer
Ch. 66

Open HyDraw ® V700

Double click the HyDraw V700 desktop
shortcut icon.

Alternatively,
Click Start
> All Programs
> VEST
> HyDraw V700
The program opens Visio and the
HyDraw V700 ribbon menu within the
Visio environment.

VEST, Inc.
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4. HyDraw V700 Ribbon Menu
HyDraw® has a new ribbon menu for ready access to the frequently used commands.

HyDraw V700 ribbon menu and submenus

VEST, Inc.
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5. HyDraw Library Explorer
The HyDraw® Library
Explorer provides access
to symbols, external ports,
and components.
Locate them using either
the tree view structure or
the search option.

Symbols and external ports inserted from HyDraw Library Explorer to design schematic

VEST, Inc.
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1

Open HyDraw Library Explorer
 Click From Library Explorer from the Insert Symbol option
on the HyDraw® V700 ribbon menu within Visio.
Alternatively,
Click

the HyDraw ribbon menu.

The HyDraw Library Explorer dockable window displays and
docks on the left of the Visio screen.

2

Move HyDraw Library Explorer
 Select the HyDraw Library Explorer using the caption bar and
drag or dock it to the desired location.
HyDraw stores the information about the docking location of the
Library Explorer.

3

Show/Hide HyDraw Library Explorer
 Use the automatic Show/Hide feature of the Library Explorer to
maximize the drawing space.
 Click
icon on the caption bar to activate the Show/Hide
feature.

HyDraw Library Explorer

VEST, Inc.
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4

Load HyDraw Library Explorer on Startup

1.

Select

2.

Click the Misc. tab.

3.

Select Library explorer from the Load on startup group box.

from the HyDraw® V700 ribbon menu.

When subsequently opened, the Library explorer docks to its
previous location.

HyDraw Options

VEST, Inc.
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6. HyDraw Property Manager
The HyDraw® Property
Manager displays assigned
properties of the selected
items, such as symbols,
port connections,
connection lines, and
systems.
Search the component or
model code with given
inputs.
Configure your own design
requirements and save the
data in the library.

Display assigned properties of the selected symbol using the HyDraw Property Manager

VEST, Inc.
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1

Open HyDraw Property Manager
Click

on the HyDraw® V700 ribbon menu

The HyDraw Property Manager dockable
window displays and docks on the right side of
the Visio screen.

The HyDraw Property Manager displays two
tabs
Selected Item and System

System tab page
Selected Item tab page
Selected Item tab
The Selected Item tab page displays the
properties of the selected component and
remains collapsed, if the item is not selected in
the drawing.

System tab
The System tab page displays properties of the
complete circuit and the page automatically
expands whenever the schematic is opened in
the Visio drawing.
When the item is selected or the schematic is
open, the respective menu bar expands and the
assigned values display.
Click

2

to expand, if it is not expanded.

Dock HyDraw Property Manager
To move the Property Manager window, select
it using the caption bar, then drag and dock it
to the desired location.
HyDraw stores the information about the
docking location of the Property Manager.

VEST, Inc.
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3

Load HyDraw Property Manager on Startup

1.

Select Options… in the HyDraw® V700 ribbon menu.

2.

Click the Misc. tab.

3.

Select the Property manager checkbox from the Load on
startup section.
Subsequently, the Property Manager opens and docks at its
previous location.

HyDraw Options: Misc

VEST, Inc.
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7. HyDraw Options
The HyDraw Options command on the HyDraw® V700 ribbon menu enables you to customize HyDraw settings, such as Application, Units, Balloon,
Connection, External Port, Parts List, Ports List, Data Path, Misc. Internet settings and QuickManifolds®.

1

Application
Select one of the three applications from Hydraulic,
Pneumatic, and Electrical.

1.

Click the Application tab.
The Application tab page displays.

2.

Select the required application: Hydraulic,
Pneumatic, or Electrical.
Select any one of the three applications.
The application is selected in the Search From
Library tab page in the HyDraw Library Explorer
dockable window.

3.

Click OK.

Application tab page

VEST, Inc.
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2

Units
Select units for the selected application.

1.

Click the Units tab.
The Units tab page displays.

2.

Select the required drawing units from Imperial and
Metric.

CAUTION!
Units should not be changed after symbol insertion.

Units tab page
3.

Click the Advanced Options.
The Modify units grid displays.

4.

Configure each unit category by selecting the
Primary Unit.

Units Tab – Advanced Options
VEST, Inc.
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5.

Select the Display alternate unit check box to
display the alternate unit along with the primary unit,
if required.
The Alternate Unit column displays.

6.

Configure the alternate units.

7.

Click Reset to restore the default units.

8.

Click OK to apply and exit.

Units Tab – Advanced Options Display Alternate Unit

Note
To display the alternate unit in the old drawing, run
Update Property List command from the ribbon menu.

Dual Units displayed in the drawing

VEST, Inc.
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3 Balloon
Enclose or balloon the envelope ID, external port ID, symbol ID, and
accessories ID.
1.

Click the Balloon tab.
The Balloon tab page displays

2.

Select the appropriate numbering scheme to assign ID to schematic,
symbol, port, and accessories.
This helps in the identification of the component.
Items numbered serially
Identical items grouped using alphabets
Identical items grouped using dot (.) separator
Identical items grouped using dash (-) separator
ISO 1219 scheme is assigned to symbols

3.

Select the Display in drawing checkbox, if you want the accessory
item ID to be displayed in the drawing.

4.

Select the As sub item of component checkbox, if the accessory
is to be numbered as the sub-item of the component.

5.

Numeric ID defines the numerical accessory item ID and
Alphabetic ID defines the alphabetical accessory Item ID.

6.

Select the List component as first sub-item checkbox,
if the component requires the first sub-item to be numbered.

7.

Select the required balloon in the Type section.
Select None, if you do not want a balloon around an ID.

8.

Select the No balloons on external ports checkbox,
if you do not want any balloon on the external port ID.

9.

Click OK.

VEST, Inc.

Balloon tab page
 Case1: If numbering scheme
is selected,
there will be no grouping of identical items.
 Case2: If numbering scheme
is selected,
identical sub-items will be grouped and numbered by using
Component ID and a Numeric ID separated by chosen Item ID
separator, e.g., 2-1A or 2.1A etc.
 Case3: If numbering scheme
is selected,
identical sub-items will be grouped and numbered by using
Component ID and a Numeric or Alphabetic ID, whichever chosen,
separated by chosen Item ID separator,
e.g., 2-1.1 for numeric ID or 2- A.1 for alphabetic ID option etc.
 Case4: If numbering scheme
is selected,
identical sub-items will be grouped and numbered by using
Component ID and a Numeric or Alphabetic ID, whichever chosen,
separated by chosen Item ID separator,
e.g., .2.1-1 for numeric ID or 2.A-1for alphabetic ID option etc.
HyDraw V700
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4 Connection
Customize line properties, line jumpers, line connections, and the
recommended velocity in a circuit.
1.

Click the Connection tab.
The Connection tab page displays.

2.

In the Line properties group box, choose the default pressure, tank,
pilot, drain, or suction line.
You can also choose other lines with customized name typed in the
text box.

3.

Click the color box to change the color.

4.

Click the combo box to select the line pattern from continuous,
phantom, and hidden.

5.

In the Line jumper section, select the size of the jumper from large,
medium, and small.
In the Line connection section, select the size of the connection dot
from large, medium, and small.
Connection dot is automatically inserted when one line terminates on
another.

6.

Set the recommended velocity for Pressure and Return Line.

7.

Click OK to apply and exit.

Connection tab page

VEST, Inc.
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5 External Port
Customize the external port in a circuit.
1.

Click the External Port tab.
The External Port tab page displays.

2.

Click an appropriate button to configure the external port to a circle,
oval, line, rectangle, or square shape.
The respective shapes display in the port preview section of the
HyDraw Library Explorer window and can be inserted on the
envelope line of the circuit.

3.

Select the Middle align checkbox to align the port co-axially with the
envelope line.
This option is applicable only for rectangle and square ports.

4.

To displays the Port configuration dialog box during automatic
insertion of ports, select the Show configuration dialog option.
While automatically inserting Gauge Port the connections are
established, per the distance from the main port(X) and the
connection distance(Y) value settings.

5.

Click OK to apply and exit.

External Port tab page

VEST, Inc.
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6 Parts List
Customize the Parts List format.
1.

Click the Parts List tab.
The Parts List tab page displays.

2.

To rename a selected format,
type the new name in the text box and then click

3.

.

To add a new format,
type the new name in the text box and then click

.

4.

To delete a selected format, click

5.

Click Select Columns.
The Select Parts List Columns dialog box displays.

.

6.

Select the appropriate box and click OK.
The selected properties are displayed in the Parts List tab pageConfigure columns.

7.

Set the Start Column and the Start Row of the Parts List to be
inserted into the Excel template.

8.

Click OK.
The selected properties display in the tabular form,
when creating Parts list in the Visio drawing.

Parts List tab page

Note
To learn more about Parts List, refer Chapter 24.
Select Parts List Columns

VEST, Inc.
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7 Ports List
Customize the Ports List format.
1.

Click the Ports List tab.
The Ports List tab page displays.

2.

To rename a selected format,
type the new name in the text box and then click

3.

.

To add a new format,
type the new name in the text box and then click

.

4.

Click Select Columns
The Select Ports List columns checklist box displays.

5.

Select the appropriate box and click OK.
The selected properties are displayed in the Ports List tab pageConfigure columns.

6.

Click OK.
The selected properties display in the tabular form,
when creating Ports list in the Visio drawing.

Ports List tab page

Note
To learn more about Ports List, refer Chapter 25

Select Ports List columns

VEST, Inc.
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8 Library Path
Multiple users get easy and hassle free access to the library and the
components data from a common source over a network.
1.

Click the Library Path tab.
The Library Path tab page displays.

2.

Select the Local Library option.

3.

Select the Enable modification check box to modify the library.

4.

Click Browse… and navigate to the folder where the HyDraw®
Library data is stored.
The Symbols and Sub-subsystems path are automatically set if the
Data, Symbols and Sub-systems folders are located at the same path.

5.

Repeat above steps for each of the specified HyDraw library paths,
if required.

6.

Select the Corporate Library option to configure the second library
path of your common Network library and repeat steps 3 to 6.

7.

Click OK.
All the HyDraw library paths are configured.

Data
The folder path that contains component data,
library listing data, and manifold manufacturing estimation data are
specified.
Symbol Library
The folder path that contains all libraries are specified.
Sub-systems
The folder path that contains user-created
circuit drawings and its menu data are specified.

VEST, Inc.

LibraryPath tab page
Note
All data paths shown are default.
You can configure to common network data paths.
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9 Misc.

9.1 Text Size

1.

Configure the text size, envelope line,
symbol color, and solenoid naming in the US and Europe pattern.

1.

In the Text size group box, select the appropriate text size from the
respective list box for item ID, display properties, and list items.

2.

Load the HyDraw® Library Explorer and the
HyDraw Property Manager into your Visio drawing during Startup.

2.

Click OK to affect the changes to the properties in the library.

3.

Click Misc. to display the tab page.

Text size section
Misc. tab page

VEST, Inc.
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9.2 Envelope Line

9.3 Load on startup

1.

In the Envelope line group box, select the appropriate line pattern
from continuous, phantom, and hidden list box options.

1.

The Library Explorer and Property Manager can be loaded to
HyDraw® on startup.

2.

Click the Color button to open the color box and select the required
color.

2.

3.

Click OK to effect the changes in the library.

In the Load on startup group box, select the application you want to
use for loading on startup.
The selected application loads and docks to the HyDraw drawing.

3.

Click OK to affect the changes.

Envelope Line section
Load on startup section

VEST, Inc.
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9.4 Symbol Color
All symbols in the HyDraw® library are assigned with the ISO defined
colors.
You can also have these symbols in black color.
1.

Select the checkbox in the Symbol color section, if you want to change
the color of symbols to black.

2.

Click OK to affect the changes in the library.

Symbol color section

VEST, Inc.
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9.5 Solenoid Naming
Solenoids in the Directional Control Valve symbols are named both in
the US and Europe pattern using the Visio layer properties.
You can view only one pattern at a time.
1.

Select the appropriate pattern.
The selected pattern will affect the change of solenoid naming of
symbols in the HyDraw® drawing.

2.

Click OK to effect the changes.

Solenoid naming –US pattern

Solenoid naming – Europe pattern

Solenoid naming section

VEST, Inc.
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10 Internet Settings
Configure the Internet connection for FluidPowerTools and QuickManifolds®.

Click
on the QuickManifolds section
of the HyDraw® V700 ribbon menu.
The Internet Settings of the HyDraw Options dialog box displays.
Note
Refer chapter 2.6 for detailed configuration.

HyDraw Options – Internet Settings

VEST, Inc.

HyDraw V700

27

11 QuickManifolds
Preserve QuickManifolds.com Logon information and select the Design data library.

1.

Click the QuickManifolds® tab.
The QuickManifolds tab page displays.

2.

Enter the Logon information, i.e. User Name and Password.
The user name and password are preserved and used to logon to
QuickManifolds.com

3.

Select QuickManifolds Library or set the My MDTools Library
path to use the corresponding library for the QuickManifolds design.

HyDraw Options – QuickManifolds

VEST, Inc.
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12 ERP Settings
Preserve the ERP settings.

Click the ERP Settings tab.
The ERP Settings tab page displays.

1.

2.

Select My local ERP data and select the Excel file path by clicking
Browse….
Or
Select Online ERP data and enter the Service URL.

3.

Select the Search using options, which is either the model code or
the part number.

4.

Enter the ERP column name.

5.

Click OK to save the ERP settings and quit HyDraw Options.

Note
Configure and place the ERPServiceConfiguration.xml at the same
location, where the ERP data file in Excel format is saved.
For details, refer Chapter 73. Configure the
ERPServiceConfiguration.xml.
HyDraw Options – ERP Settings

VEST, Inc.
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Inserting Symbols
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Inserting Gauge Port
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Searching Components
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Searching Sub-systems
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Inserting from Parts List
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Inserting from DC Valve Configurator

15

Inserting Envelope
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8. Inserting Symbol
Insert symbols, external ports, and component models into the drawing.
The Component library is a logically structured symbol library of
hydraulic, pneumatic, and electrical systems.

Logically structured Component Library

VEST, Inc.
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1 Insert a symbol into the drawing
1.

Select the appropriate library and navigate to the
required symbol.

2.

Drag the symbol from the HyDraw® Library
Explorer window into the drawing.

Note:
The Mobile Valve symbols are smart symbols
and they can be configured from the context
menu by right clicking over the symbol.

Drag and drop symbol from Component Libraryinto the Visio drawing

2

Replace Symbol

1.

Select the Replace symbol checkbox in the
HyDraw Library Explorer window to replace the
symbol in the drawing,
if required.

3.

Drag and drop the new symbol over the old
symbol in the drawing.

Replace Symbol from Component Library into the Visio drawing

VEST, Inc.
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9. Inserting External Port
Insert ports on the envelope line in a circuit drawing.
Configure and edit the ports to suit the circuit requirements.
1.

Click
tab on the HyDraw® Library Explorer window.
The External Port Library tab page displays.

2.

Click
on the Configure External Port caption bar to expand,
if the section is not open.

3.

Type the Item ID in the text box,
for example, P, T, 1.
The default Item ID is ‘?’.

4.

Select Pressure line port or Return line port.

5.

Enter parameters for Pressure and Flow.

6.

Select Port Type from SAE O-ring, SAE Flange, BSP, NPT, and
Metric.
On selection, different port sizes of the respective port type are
displayed automatically.
Choose the required one.

7.

Select and drag the plugged or unplugged port from the preview
section into the drawing.
If the port symbol is placed over the envelope line, it attaches itself to
the envelope line.
When moved, it moves along the envelope line.
When a connecting line connects to the envelope line, an external
port is inserted automatically at the point on the envelope.
External Port Library tab page
The port displays a red square with white background.
When a proper connection is made, the red square disappears.
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1 Replace External Port
1.

Replace the port in the drawing with another port from the library
by selecting the symbol.

2.

Select the Replace symbol checkbox in the HyDraw® Library
Explorer window, if required.

3.

Drag and drop the new symbol over the old symbol in the
drawing.

External Port inserted into the drawing

Replace symbol, Unplugged with Plugged External Port
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2 Fetch Port from Library
1.

Select the external port.

In the HyDraw Property Manager, Selected Item, specify the Design
requirements, Pressure, and Flow.
2.

Click

in the Design requirements section.

4.

The Edit Port Operating Parameters dialog box displays.

3.

The Flow and Pressure are automatically picked up from the
Design requirements. If any changes are required, modify and
click OK.

4.

Select the Fetch from Library icon.

5.

The Fetch Port from Library dialog box displays.

5.

Select Pressure line port or Return line port.

Edit Port Operating Parameters

6. Select Port type on the basis of the design requirements.
The port size is automatically selected.

7.

Click OK to apply and exit.

Note
The port data can embed With O-ring and With Through Bolt Hole
from HyDraw® to MDTools®.
Fetch Port from Library
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3 Configure External Port
Configure external ports to different shapes.
1.

Select

from the HyDraw® V700 ribbon menu.

2.

Click the External Port tab.
The External Port tab page displays.

3.

Click the appropriate shape to configure the port shape to
a circle, oval, line, rectangle, or square.
The respective shape displays in the Port Preview section of the
HyDraw Library Explorer window.
The external port can be placed on the envelope line of the circuit.

4.

5.

6.

Select the Middle align checkbox to align the port co-axially with the
envelope line.
This option is applicable only for rectangular and square ports.

External Port tab

Select the Show configuration dialog checkbox to display the
Configure Port dialog box, when the ports are automatically inserted
on the envelope line by drawing a connection line.
Alternatively, the Configure Port dialog box appears on clicking the
Fetch from Library Icon from the HyDraw Property Manager.
Click OK to apply and exit.

Configure Port dialog box
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10. Inserting Gauge Port
Automatically add a gauge port in parallel to an existing external port.
1.

Set the Gauge port insertion distance default values in the
External Port tab of the HyDraw® Options dialog box.

2.

Select the external port in the circuit drawing,
where you want to add the gauge port in parallel.

Configure the External Port
1.

Select the Insert a gauge port check box in the External Port
Library tab.

2.

Drag and drop the gauge port symbol on the side of the selected
external port, where you want it to be inserted.
The gauge port is inserted and connected in parallel to the selected
external port.

External Port tab, set the gauge port distances

Gauge port G1 is inserted in parallel to the existing selected external port
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11. Searching Components
The Search From Library feature is used to search a component or sub-system from the library.
Search the Model Family or Model Code of a component type or category of a particular manufacturer or different manufacturers.

1 Search Components
1.

Click
tab on the HyDraw® Library
Explorer window.
The Search From Library tab page displays.

2.

Select Components.

3.

Select the appropriate application.

4.

Select appropriate search database,
My local database or FluidPowerTools.com
database.
If the My local database option is selected,
the program searches components in the
user’s local database.
If the FluidPowerTools.com database option
is selected,
The split button on the right is enabled,
use the data access settings.
In Data Access Settings, select the
manufacturer database to search
components.

Data Access Settings
The Data Access Settings drop down provides
other controls, which includes:
 Data Access Settings
 Data Library &Help
 Usage terms and conditions
 My Subscription information
 Contacts…

Default Search tab page
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5.

Select the manufacturer from drop-down list,
if My local database is selected.

8.

Enter Model Code.

Enter Model Code
Manufacturer options
9.
6.

Define more criteria.

Manufacturer options
Enter the Model Code to search the particular component
For precise search, define custom search parameters in the Define
more criteria section.
Click

to view the Select Property box, which displays all
possible properties

Define More Criteria options

Select the property you want to assign.
Enter the property value, for example 10,
or range, for example 10-20.
Property range must be separated by a hyphen (-).n
7.

10. Select Property

Select the appropriate component type.

Select Property

Component type options
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11. Click the Search for Model Code button.
All model codes with the assigned custom properties are displayed in
the Search results pane.

12. Select the appropriate model code in the preview pane.
The Search results are displayed in the pane.

Searching model code with precise criteria

Preview symbols
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13. Right click and select View Model
Properties from the context menu to
display the component data window.
The Component Model Properties
window displays details about the
component.

Model code context menu
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14. Click search for Model Family.
All model families with assigned custom properties are displayed
in the Search results pane.

15. Right click and select Search for Complete Model Code from
the context menu to display all model codes in the model family.

Model Family search results
Model Family context menu

VEST, Inc.

HyDraw V700

42

16. Click Modify Search to return to the main search window
and search with different inputs, if required.

17. Select the symbol in the preview pane;
drag and drop it into the drawing.
18. Replace the symbol in the drawing with another one from the library
by selecting the Replace symbol checkbox in the HyDraw® Library
Explorer window, if required.
19. Drag and drop the new symbol over the old symbol in the drawing.

Symbol dragged and dropped into the drawing

Modify Search
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12. Searching Sub-systems
1.

Click
tab on the HyDraw® Library Explorer window.
The Search From Library tab page displays.

2.

Select Sub-systems.

3.

Select the appropriate application.

4.

Category options

Sub-systems tab page
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5.

Select the appropriate manufacturer.

6.

Enter the Model Code to search the particular component
a.

For precise search, define custom search parameters in the
Define more criteria section.

b.

Click
to view the Select Property box, which displays all
possible properties.

c.

Select the property you want to assign.

d.

Click OK.

Manufacturer options
Searching model code with precise criteria
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7.

Click the Search button.
All sub-systems with assigned custom properties
display in the Search results pane.

8.

Click on the search results to display the
selected sub-system in the preview pane.
The Component Model Properties window
displays details about the sub-system.

Search Model Code
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9.

Right click and select View Model Properties from the context menu
to display the component data window.

10. Select the sub system in the preview pane; drag and drop
it into the drawing.

View data

Sub-system dragged and dropped into the drawing
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13. Inserting from Parts List
Insert symbols from Parts List in the Excel sheet. Each part in the Parts List is identified by its unique model code.
Therefore, the parts list must contain a model code for each part in the list.
Insert Symbols from Parts List
1.

Select From Parts List from the Insert Symbol option on the
HyDraw® V700 ribbon menu.
The Insert Symbol from Parts List dialog box displays.

Select Parts List Excel File dialog box
Insert Symbols From Parts List dialog box
2.

HyDraw sets Part list starting rows at from the HyDraw Options –
Part List or you can enter the value.

3.

Enter Model Code column number in the textbox, if you know.

VEST, Inc.

4.

Click Browse...
The Select Parts List Excel file dialog box displays.

5.

Select the required file.
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6.

Click Open.

7.

The complete Parts List displays in the Excel sheet.

12. Click Insert All to insert all symbols from the list into the drawing.

8.

Select the part or component symbol you require.

9.

Click Insert to insert it into the drawing.
A message box displays and notifies to select a point on the drawing,
where you want to insert the symbol.

10. Click Cancel, if you want to abort the command.

Note


Envelopes and accessories are not inserted.



Components without Model Code are not inserted.

The components (rows), which are not inserted, are highlighted in red.

11. Select the point on the drawing, where you want to insert the symbol.
The symbol displays on the drawing.

Symbol inserted into the drawing
Insert Symbol from Parts List dialog box
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14. Inserting from DC Valve Configurator
Configure dynamically both proportional and non-proportional stackable and non-stackable Direction Control (DC) valves with customized flow paths.
Insert the configured valve into the drawing.

1.

Select From Configure DC Valve from the Insert Symbol option
on the HyDraw® V700 ribbon menu.
The DC Valve Symbol Configurator dialog box displays.

2.

Select the Proportional DC valve checkbox, if you want to
configure the proportional DC valve from the Valve type group box.

3.

Select the appropriate operator.

Operator options

DC Valve Symbol Configurator window
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4.

Select the appropriate function.

5.

Select the appropriate size.

6.

Select Stackable symbol, if you want to configure a stackable valve.

7.

Click Change pattern, if you want to make any changes.
The Select Pattern dialog box displays and shows the available
patterns.

Function options

Size options
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8.

Select the appropriate pattern and click OK.
The Directional Control valve symbol displays in the pane.

9.

Click each “?” box in the Flow Path section to select the appropriate
flow path.
The Select Flow Path window displays.

10. Select the required flow path and click OK.

Different Patterns
Select Flow Path window
11. Click Show Preview to view the selected DC valve in the preview
pane.

12. Click Insert to Drawing to insert the symbol into the drawing.
The symbol is inserted into the drawing.

Dynamically configured DC valve preview window
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15. Inserting Envelope
Insert an envelope to define a boundary for a manifold or a system.

1.

Click
Envelope from the HyDraw® V700
ribbon menu.
The Visio cursor changes into a small square
box.

2.

Select a point on the drawing,
click and drag to create an envelope.
The selection point and endpoint mark the
diagonal corner points of the envelope.

3.

Ribbon menu for
Envelope, Terminator,
Interruption Points, and Connection Points

Envelope defining the boundary of a symbol

To resize the envelope,
select the envelope and drag it by the midselection point or the corner selection point.

Note


By default, the size of the envelope is unlocked.



It must be unlocked using the (Un)Lock Size
command, before resizing it.
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16. Inserting Connection
Interconnect symbols and create a circuit. Jumpers and line connections or connection dots are inserted dynamically, where connecting lines cross each other
or where one connection line terminates on the other.

1.

Click Insert Connection on the HyDraw® V700 ribbon menu.

2.

Select the Connection type from Pressure, Tank, Pilot, Drain,
Suction, or, Custom from Line1, Line2, Line3, Line4, and Line5.
Connection lines are assigned with default ISO color and line weight.
You can customize the connection lines.

Line Connection and Line Jumper
Line connection or Connection dot is inserted, where one line
terminates on the other.
When the connection is not intended, lines are shown crossing each
other or jumping over the other.

Insert Connection submenus

 Select the appropriate size of the connection dot and jumper from
the Options menu.
Connection dot and jumpers are inserted dynamically.

Note
The connection line properties cannot be applied to multiple selections.
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17. Connecting Lines, Ports, and Symbols
1.

Select the Connection type from Pressure, Tank, Pilot, Drain,
Suction, or Custom from Line1, Line2, Line3, Line4, and Line5 from
the HyDraw® V700 ribbon menu.
Connection lines are assigned with default ISO color and line weight.
You can customize the connection lines.

2.

Select any point on the drawing, where you want to start or
end the connection.

3.

Specify the start point of the connection and drag to the endpoint,
where you want the connection to terminate.

4.

To connect two ports of different symbols,
click one port of a symbol and drag to the other port.
The connection line snaps to end points and becomes straight
dynamically, if drawn with kinks.

5.

To connect one port of a symbol with the envelope line,
click the port of the symbol and drag on to the envelope line
or vice versa.
External port is inserted dynamically on the envelope line,
when a line connects the envelope line.

6.

To move the connection line,
select and drag the connection line by the mid point to the
desired position.

7.

To stretch the connection line,
select and drag the connection line by the endpoint to the
desired position.

8.

.To deletes a connection line,
select the connection line and press the Delete key.

When two lines cross each other, a jumper is inserted over one line
dynamically. This indicates the connection is not intended.
When one line terminates on another,
a connection dot is inserted dynamically on the connection point.
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Note


When you connect a connection line to a symbol port,
the red square at the port connection point disappears.
This indicates that the connection line is connected to the symbol
properly.



To insert Jumpers automatically for non-intersecting connection lines,
set this option in the Misc. tab of the HyDraw® Options ribbon menu.



Connection dots are inserted automatically when one connection line
terminates on the other.



When you delete the connection line, the red square at the port
connection point to which the connection line is attached, becomes
visible again.
This indicates that the port connection point is unattached.
Stretch connection by endpoint

Connection lines inserted to create circuit
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18. Fetching Pipe and Tube Data from Library
Connection lines can be assigned with the Tube and Pipe data from the Library based on the design requirements.
1.

Select the connection line.

2.

Specify the Design requirements, Pressure and Flow for the
selected connection line in the HyDraw Property Manager.

3.

Click the Fetch from Library icon.

6.

The Fetch Pipe/Tube from Library dialog box displays.

4.

Select either the Pressure Line or the Return Line.

5.

Select the Type, i.e. Tube/Pipe.

6.

Select the Material.
The available Tubes and Pipes are displayed based on the design
requirements and velocity.

7.

Select the pipe or tube.

8.

Click OK to select and exit.

HyDraw Property Manager – Connection Data

Fetch Pipe/Tube from Library
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19. Inserting Terminators
Insert terminators dynamically at the unused component ports and unconnected connection lines.

1.

Select the symbols or the circuit lines for the terminator insertion.

2.

Click Terminator

from the HyDraw® V700 ribbon menu.

Terminators are inserted automatically at all the unused ports of all
selected symbols and unused connection lines.

Note


The terminator indicates the unused component port.



Terminator is essential in the Net List creation.
A net remains incomplete, if a port is left unconnected.



The Net List can indicate unconnected circuit lines and ports.
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20. Inserting Interruption Point
Insert interruption points to correlate connection lines, parts of which lie on different pages in the Visio drawing file. This is applicable for larger schematics that
spread into multiple pages.
The Interruption Point –Outgoing notifies the outgoing connection on the connection line on the page.
The Interruption Point –Incoming notifies the corresponding connection on the connection line on a different page.

Insert Interruption Point – Outgoing
 Select Interruption Point – Outgoing
V700 ribbon menu.
An Interruption Point
connection line.

Insert Interruption Point – Incoming
 Select Interruption Point – Incoming
V700 ribbon menu.

from the HyDraw®

is inserted automatically at the outgoing

An Interruption Point
connection line.

Interruption Point –Outgoing
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Interruption Point – Incoming
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21. Inserting Connection Point
Insert connection points on the ports of a symbol.
1.

Select the symbol.

2.

Click Connection Point
on the HyDraw® V700 ribbon menu.
The Insert Connection Point dialog box displays.

4.

Click Insert.
The message, Press ‘Ctrl’ and Click to add connection point,
displays in the Insert Connection Point window.
Simultaneously, the cursor changes to a small cross in the drawing.

5.

Move the pointer at the point on the symbol,
with the Ctrl key pressed, to the place where you want to insert the
connection point. Then, click to add the connection point.

Assigning port name
3.

Type the Port name and the optional Other name in the text box.
The name should be the same as that of the port on which you want
to insert the connection point, for example, P.
Do not enter any other character other than the port name.

Inserting connection point

Note
The connection points inserted using the Visio commands will not
function correctly in HyDraw®.
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22. Selected Item Properties
Display the assigned properties of the selected symbol in the drawing. Add new accessories to the symbol and save in the library.
Select the symbol on the drawing.
The Selected Item tab page displays the following sections

1

Symbol

2

The Symbol section
displays the ID, balloon
style, and various settings
of the symbol.

Design Requirements
The Design Requirements section enables you to search the
required components with a specific parameter and value, for your
design, from the library.
 Type the value in the text box of the respective parameter.

 Customize the balloon
style to circle, oval,
rectangle, rounded
rectangle, or none of
these.

 Click
on the Design requirements caption bar to open the
Edit Design Note page to make relevant entries for future
reference.
 Click
on the Design requirements caption bar to open the
Edit Port Operating Parameters dialog box.

 Show or Hide various
settings with the
symbol on the drawing.

 The flow and pressure are automatically selected from the Design
requirements. If any changes are required, then modify and
click OK.

Click
to expand
and then select
Hide/Show to hide or
show the respective
parameter.
 Select the checkbox on
the caption bar to
include the Selected
Item properties in the
respective component
Parts List of the circuit.

Edit Design Note

Edit Port Operating Parameters

Selected Item tab page
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3 Model Data
The Model Data section displays the details of the component
selected.

Fetch from Library


Fetch model data for a component using either the
Local database installed on the system
OR
Online database of FuidPowerTools.com
 Enter the required criteria in the Model Data section.
 Click
on the Model Data caption bar to fetch the component
from the library.
The Fetch from Library dialog box displays with the input data.
Fetch from Library - Data Access Settings



Select the database to search, i.e.,
My local database or Fluidpower.com
If the My local database option is selected,
the program searches the component in the local database of the
user.

The Data Access Settings drop down provides other controls,
which includes:
Data Access Settings, Data library& Help topic, Usage terms and
conditions, My Subscriptions information, and Contacts.
 Click Models linked to symbol to display the component models
linked to this symbol.

If the FluidPowerTools.com database option is selected,
the split button on the right is enabled,
use data access settings.
 In the Data Access Settings, select manufacturer database to
search components.



Click All models to display all component models available to
the component type of the symbol.

 Click the Search button to search for the component.
The search results display in the Search results pane.
 Click OK.
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Add Accessories
You can add or replace accessories of the model code to the symbol
by selecting an appropriate button.


Select the Include accessories check box,
and then select Add.
The linked accessories of the component model will be added
to the selected model.

Replace Accessories
 Select the Include accessories check box,
and then select Replace.
The linked accessories of the component model will be added
to the selected model and all accessories linked previously will
be delinked.

Saving Model Data into Library
You can save the designed component with customized data in the
library.

Fetch from Library with Search results

 Click
on the Model Data caption bar to save custom details
in the library.

Note:
To undo the changes, use the Undo function in Visio.
Save to Library
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4 Accessories
The Accessories section displays the details of
accessories assigned with the item.
This section also displays all documents and CAD
files linked with the accessory.
Select from Library
You can fetch required accessories to your
component from the library.
1.

Click

on the Accessories caption bar.

The Select Accessories from Library dialog box
displays.
2.

Select the required manufacturer and component
type.

3.

To refine the search, type the Model Code,
and then click Search.
All available accessories of the selected
component type display in the Available
accessories pane.

4.

Define more criteria,
For precise search, define custom search
parameters.

5.



Click
to view the Select Property box,
which displays common properties of the
selected Model.



Select the property you want to assign.



Click OK.

Click Search.

Fetch Accessories from Library

All available accessories of the selected
component type display in the Available
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accessories pane.
6.

Select the model code you want to add to your
circuit.

7.

Click Add.
The added model codes display in the Selected
accessories pane.

8.

Select the model code and click Remove to
remove the selected model code from the
selected accessories pane.

9.

Click OK.
All the selected accessories are added to the
component and displayed in the Accessories
pane on the Selected Item tab page.

Selected accessories
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Add New Accessories
You can add new accessories to the selected
item and save in the library.
 Click

on the Accessories caption bar.

The Add New Accessory dialog box
displays.
 Select the appropriate component type you
want to add.
 Click OK.
The accessories are assigned to the
component and displayed in the Accessories
pane.
 Click
to expand the newly added
accessories menu.
 Fill in the required data in the appropriate text
box.
Add New Accessory window
Save Accessories
You can save the newly added accessories to the
component.
 Click

Accessories section

on the Accessories caption bar.

The Save to Library dialog box displays.
 Click OK
Save to Library

The new accessories are saved.
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Delete Accessories
 Select the accessory you want to remove.
 Click
on the Accessories caption bar to
delete the accessory.
The accessory is deleted from the
component.

Accessories deleted from library

VEST, Inc.

HyDraw V700

69

5 Document

6 CAD Files

The documents linked with the selected component model are
displayed. You can delete and link documents from the library.
Click

The CAD files linked with the selected component model are displayed.
You can delete and link CAD files from the library.

on the Documents caption bar to delete the linked document.

Click
Select from library to link new documents to the selected
component model.

on the CAD Files caption bar to delete the linked CAD files.

Click
Select from library to link new CAD files to the selected
component model.

Document
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23. System Properties
When you open a schematic in the Visio drawing, the System tab page displays the assigned properties of the selected system in the drawing.
Add new accessories to the system and save in the library.
1.

Components
The Components section displays the model codes of all
the components in the circuit.
 Select the Item ID to highlight the corresponding
component in the drawing.

2.

External Ports
The External Ports section displays the ID and the size
of all external ports in the circuit.
 Select the Item ID to highlight the corresponding
external port in the drawing.

3.

Envelopes
The Envelopes section displays the ID of the envelopes.
 Select the Item ID to highlight the corresponding
envelope in the drawing.

4.

Accessories
The Accessories section displays the details of
accessories assigned with the circuit.
Schematic
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24. Copying Properties
Copy component data, design requirements, and accessories, if any, of one component symbol with another component symbol of the same category.
1.

Select the source component symbol in the HyDraw® drawing.
The data of the component can be viewed from the Selected Items
properties tab page in the HyDraw Property Manager.

2.

Click Copy Properties
on the HyDraw V700 ribbon menu.
The Copy Properties dialog box displays.
Note

3. The command becomes available only when the source symbol is
selected.
4.

Select the required properties you want to copy from the Model data
checklist box.

5.

Select the required design requirements, if you want to copy from the
Design requirements checklist box.

6.

Select the Include accessories checkbox, if you want to copy the
accessories to the destination symbol.

7.

Select linked documents and linked CAD files checkboxes, if you
want to copy the linked documents and CAD files to the destination
symbol(s).

8.

Select the destination symbol(s), for the properties of the source
symbol to be copied to.
The properties are copied to the destination symbol(s).

Copy Properties
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25. Refreshing Properties
Update property values of symbols or the system from HyDraw® Library.
1.
2.

Click Refresh properties
on the HyDraw V700 ribbon menu.
The Refresh Properties dialog box displays.
Select any one of the three options,
 Click the Active page button to select the drawing in the Active
page.
 Click the All pages button to select the whole document in the
file.
 Click the Selected symbols button to select the specified
component symbols.

3.

Select the items to be included,


Select the Components checkbox to include all components in
the Refresh properties.



Select the Component accessories checkbox to include all
component accessories in the Refresh properties.



Select the System accessories checkbox to include all system
accessories in the Refresh properties.

4.

Click Next.
The Refresh Properties value dialog box displays.

5.

Select individual properties to Refresh or Select All.

6.

Click OK.
The Update message box displays.

7.

Click OK to apply and exit.
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26. Updating Property List
Update the properties of symbols or system from the HyDraw® Library.
Display properties with the alternate units.
1.

Click Update Property List
ribbon menu.
The Update Property List dialog box displays.

2.


on the HyDraw V700

Select any one of the three options,
Click the Active page button to select the drawing in the Active
page.



Click the All pages button to select the whole document in the
file.



Click the Selected symbols button to select the specified
component symbols.

3.

Select the Components, External Ports, Connection Lines,
Component accessories and System accessories checkbox to
include in the Update Properties List.

4.

Click Next.

5.

Update Properties List

Select the items to be included,


Add new model and design properties



Add new display formats



Update property definitions



Delete unused properties

6.

Click Back to change the selection.

7.

Click Update.
The Update Property List message box displays the status.

8.

Click OK to apply and exit.
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27. ERP Interface
Fetch the data from the ERP data file in the Excel format.
1.

Click
on the HyDraw V700 ribbon.
The Select item dialog box displays.

2.

Select any one of the three options:
Click the Active page button to select the drawing in the Active
page.
Click the All pages button to select the whole document in the file.
Click the Selected symbols button to select the specified
component symbols.

3.

Select the Components, Component accessories and System
accessories, as required.

4.

Click OK.
The Fetch Data From ERP dialog displays.
The columns get populated with the matching Model codes values
Partially matching Model Codes are displayed with the Select link.
a.

Click the Select link.

7.

The Select Model dialog box displays.

b.

Select the Model Code, as required.

ERP Interface-Select item dialog

Select Model dialog

c. Click OK.
The highlighted cells indicate the matching values with the selected
components & accessories.
5.

Click Update to update the selected row.

6.

Click Update All, to update all the rows in the drawing.

7.

Click Cancel to exit.

VEST, Inc.

Fetch Data From ERP

HyDraw V700

75

Modifying Symbols

VEST, Inc.

28

Aligning Symbols

29

Rotating Symbols

30

Flipping Symbols

31

Aligning Symbol Ports

32

Aligning System Port Names

33

Editing Port Name

34

Editing in Place

35

Editing Solenoid Information

36

Changing Text Height

37

Rotating Property Text

38

Unlocking Position

39

Unlocking Size

40

Relocating Symbol

41

Constraining/Unconstraining Symbols

42

Stacking Symbols

43

Reassigning Item ID

44

Updating Balloons

HyDraw V700

76

28. Aligning Symbols
Align one symbol with another symbol, horizontally or vertically, from left, right, or middle.
1.

Select the symbols you need to align.

2.

Click Align Symbols

on the HyDraw® V700 ribbon menu.

The Align Symbols dialog box displays.

Symbols aligned horizontally from left
Align Symbols dialog box
3.

Click
, , or
on the Horizontal pane to align symbols
horizontally from left, middle, or right.
Or,
Click
,
, or
on the Vertical pane to align symbols
vertically from top, middle, or bottom.
Symbols aligned vertically from top left

4.

Click OK to align the symbol.
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29. Rotating Symbols
Rotate a symbol, 90 degrees to its left or right. The associated text is constrained to remain horizontal.

Rotate Left

Rotate Right

1.

1.

2.

Select the symbol you want to rotate.
Click Rotate Left
on the HyDraw® V700 ribbon menu.
or
Select Rotate > Left from the context menu.

2.

Select the symbol you want to rotate.
Click Rotate Right
on the HyDraw® V700 ribbon menu.
or
Select Rotate > Right from the context menu.

The symbol rotates 90 degrees to its left.

The symbol rotates 90 degrees to its right.

Select a symbol

Rotate symbol to the right
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30. Flipping Symbols
Flip a symbol horizontally or vertically. The associated text is constrained to remain horizontal.

Flip Horizontal

Flip Vertical

1.

1.

Select the symbol you want to flip.

2.

Click
Flip Vertical from the Modify Symbol option on the
HyDraw® V700 ribbon menu.

2.

3.

Select the symbol you want to flip.
Click
Flip Horizontal from the Modify Symbol option on the
HyDraw® V700 ribbon menu.
or

or

Select Flip > Horizontal from the context menu.

1.

Select Flip > Vertical from the context menu.

The symbol flips horizontally.

2.

The symbol flips vertically.

Symbol inserted in the drawing
horizontal
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Flipping the symbol

Flipping the symbol vertical
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31. Aligning Symbol Ports
Align ports of different symbols horizontally or vertically.

1.

Click Align Symbol Ports

3.

Click the Symbol to move button in the Select pane
to select the symbol you need to align.
A red dot appears along the port to be aligned.

4.

Click Next Port, if you don’t want to align this port and another port.

5.

Click the Symbol to align with button in the Select pane to select
the other symbol, which you need to align it with.

on the HyDraw® V700 ribbon menu.

Align symbol ports menu

Align Symbol Ports dialog box

Symbol ports aligned vertically

Symbol ports aligned horizontally

A red dot appears along the port to be aligned.

6.

Click Next Port, if you don’t want to align this port and another port.

7.

Click

in the Alignment pane to align ports horizontally, Or

Click

in the Alignment pane to align ports vertically.

8.

Click OK.
The symbols are aligned with reference to their ports.

Note
When you align symbols, the first symbol gets constrained to the
second symbol and moves with it till you manually relocate the first
symbol.
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32. Aligning System Port Names
Align port names of all the selected ports horizontally or vertically.
1.

Select the system ports, which names you need to align.

2.

Click Align System Port Names
ribbon menu.

on the HyDraw® V700

In the given selection, the left and bottom port name is taken as
reference and all other system port names are aligned in a single line
parallel to the envelope.

Align submenu
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Selected system ports

System port names aligned
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33. Editing Port Name
Edit the port name or the other name of the selected symbol in the drawing. This does not affect the master symbol in the HyDraw® library.

1.

Select the symbol to edit its port name.

2.

Click Edit > Port on the HyDraw V700 ribbon menu.
The Edit Port dialog box displays.

3.

Type the new name in the Name column and the optional Other
name.

3.

To delete the port, click

4.

Select Name/Other name in the Display option. .

5.

Click OK.
The Name/Other name of the port displays with the symbol.

.

If both the names are selected, then dual port names are displayed.
Edit submenu

Edit Port dialog box

Symbol with unedited ports

Symbol with Name and Other name

Note
Changes affect only the symbol in the drawing and not the master
symbol in the HyDraw Library.
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34. Editing in Place
Edit the selected symbol in the drawing. It does not affect the master symbol in the HyDraw® library.

1.

Select a valid HyDraw symbol.

2.

Click Edit symbol
on the HyDraw V700 ribbon menu
The Symbol stencil opens for edit.

3.

Use Visio > Home > Tools
or
The drawing commands to draw and edit the symbol.

4.

Opened symbol stencil for edit

Close the window after you make the changes.

Note
Changes affect only the symbol in the drawing and not the
master symbol in the HyDraw Library.
Symbol after edit
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35. Editing Solenoid Information
Edit the Solenoid ID of the selected symbol and Function in the drawing. It does not affect the master symbol in the HyDraw® library.

1.

Select a valid HyDraw symbol.

2.

Click Edit Solenoid Info
on the
HyDraw V700 ribbon menu
The Symbol stencil opens for Edit Solenoid
Information.

3.

In the Solenoid ID column, edit the ID, if already
available, or enter a new ID.
The Show check box changes the visibility of the ID
and Function for the selected symbol.

4.

In the Available Functions section, enter the
Function name and click the Add button.
The Update button allows editing the existing
function.

5.

Select the solenoid name.

6.

Select the function.

7.

Click the Add selected function button.
The selected function is added to the selected
solenoid name.

8.

Click OK to close the window and to make changes.

Note
Changes affect only the symbol in the drawing and not
the master symbol in the HyDraw Library.
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36. Changing Text Height
Change the text height of the displayed Item ID and other parameters of the selected symbols.

1.

Select the symbol to change its text height.

2.

Click Change Text Height on the HyDraw® V700 ribbon menu.

The Change Text Height dialog box displays.

3.

Enter the new text height.

4.

Select Update Item ID to change the item ID text height.

5.

Select Update property text to change the text height of the
displayed parameters.

6.

Click OK.
The height of the text is changed.

Change text height dialog box

Text height changed (Before and After)
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37. Rotating Property Text
Rotate the text properties of the selected symbol, external port, and connection line.

1.

Select the symbol/external port/connection line to rotate its
property text.
Click Rotate Property Text on the HyDraw® V700 ribbon
menu.
Symbol – Property text rotated

The Rotate Property Text dialog box displays.
2.

Select the property you want to rotate.

3.

Click Rotate Left
The Property Text rotates 90 degrees to its left.

4.

Click Rotate Right
The Property Text rotates 90 degrees to its right.

5.

Click OK.
The property of the text is rotated.
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Rotate Property Text dialog box
External Port - Property text rotated

Connection Lines – Property text rotated
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38. Unlocking Position
Lock the position of a symbol to prevent its inadvertent movement.
Move the symbol to a different position after unlocking it.
Lock Position
1.

Select the symbol to lock its position.

2.

Click Position
from the (Un)Lock option on the HyDraw® V700
ribbon menu.
The symbol gets locked at its current position.
A lock image displays at the left bottom corner of the symbol.

Symbol in locked position

Unlock Position
1.

Select the symbol that is locked or the symbol you want to unlock.

2.

Click Position
ribbon menu.

from the (Un) Lock option on the HyDrawV700

Alternatively, click
on the HyDraw V700 ribbon menu.
The lock image disappears.
Move Symbol
You can move a symbol in the schematic from one location to another,
while retaining its connections.
1.

Select the symbol (position unlocked) you want to move.

2.

Drag it to the desired location.
Alternatively,
Use arrow keys on the keyboard to move it left, right, up, or down.
The symbol is moved to the new location, while retaining its
connections.
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Symbol moved to new location: retaining connections
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39. Unlocking Size
Prevent inadvertent increase or decrease of the original size of the symbol by locking it. All symbols are locked when inserted into the drawing.
Use the (Un)Lock command to unlock and then change the symbol size.
Lock Size
1.

Select the symbol to lock its size.

2.

Click Size
from the (Un)Lock option on the HyDraw® V700
ribbon menu.
The size of the symbol gets locked. Small black color filled squares
appear at the corners and middle of the boundary box of the symbol.

Symbol size locked

Unlock Size
1.

Select the symbol to unlock its size.

2.

Click Size
from the (Un)Lock option on the HyDraw V700
ribbon menu.
Alternatively,
Click
on the HyDraw V700 ribbon menu.
The small black color filled squares change to blue.

Resize Symbol
1.

Select the symbol (size unlocked) in the drawing to resize it.
The resize shape option appears automatically, when the cursor is
close to the boundary box corner points.

2.

Drag it to the required size.

VEST, Inc.

Resizing the symbol

Note


The symbol size gets automatically locked when you drag and drop a
symbol from the library to the drawing.



Always resize the symbol from the corner point of the boundary box
and do not resize from the middle point.
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40. Relocating Symbol
Position a symbol relative to another symbol in the drawing by taking the port as reference.

1.

Select the symbol to relocate.

2.

Click Relocate
on the HyDraw® V700 ribbon menu.
or
Alternatively select Relocate from the context menu.
The Relocate Symbol dialog box displays.
The selected symbol is encircled with a green envelope and a red
dot on the first inserted port.
This port reference can be changed by clicking the Next Port.

3.

Select Reference symbol.
The selected symbol is encircled with the red envelope and displays
X, Y co-ordinates with the red dot on the first inserted port.

Relocate Symbol

This port reference can be changed by clicking the Next Port.
The coordinates in the dialog box display the location of the symbol
to be moved (green envelope) with respect to the selected reference
port.
4.

Specify the new X and Y location.

5.

Click OK.
The green envelope symbol moves to the specified X and Y location
with reference to the red enveloped symbol.
Relocate Symbol with X at Zero
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41. Constraining/UnConstraining Symbols
The Constrain command enables you to constrain symbols to another symbol of the selected symbols in the drawing.
The UnConstrain command enables you to remove constrains of the selected symbols.
Constrain
1.

Select the symbols to constrain.

2.

Click Constrain
on the HyDraw® V700 ribbon menu.
The Constrain symbols dialog box displays.
All the selected symbols are encircled with a green envelope.

3.

Select Symbol to constrain with.
The selected symbol is encircled with a red envelope.

4.

Click OK to constrain the symbols to another symbol.
All the constrained symbols show the constrained sign

Constrain Symbols
.

UnConstrain
1.

Select the constrained symbols in the drawing.

2.

Click UnConstrain
on the HyDraw V700 ribbon
menu.
All the constrained symbols are unconstrained.
Symbols Constrained

Note
Constrained symbols cannot be moved or relocated independently.
When the "symbol to constrain with" is moved, the constrained symbols
move with it.
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42. Stacking Symbols
Stack the symbols horizontally or vertically.
1.

Select the symbols to stack.

2.

Click Stack
on the HyDraw® V700
ribbon menu.
The Create Stack dialog box displays.

3.

Click
or
top or bottom symbol to
move the stack.

4.

Click
or
the stack.

5.

Click OK to stack the symbols.

left or right symbol to move

Note


Port ‘P’ is the default alignment guide.



If there is no ‘P’ port, then port ‘X’ is used (e.g.
Slip-in cover).
In all other cases, Symbol Alignment box
center is used to align the symbols.



Move the stack by holding the symbol without
the constrain image.



Selecting the symbol and clicking the

Symbols stacked and constrained

Symbols to Stack

sign, removes the constrains.

Create Stack
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43. Reassigning Item ID
Reassign the Item IDs of all symbols in the circuit after modification.

1.

Click Reassign Item ID on the HyDraw® V700 ribbon menu.

3.

Alternatively,
Click
on the HyDraw V700 ribbon menu.
The Reassign Item ID dialog box displays.

2.

Select any one of the three options,
 Click the Active page button to select the drawing in the Active
page.
 Click the All pages button to select the whole document in the
file.
 Click the Selected symbols button to select the specified
component symbols.
Reassign Item ID

3.

Enter the starting value of the item ID.

4.

Enter the Assembly ID.

5.

Choose the Balloon shape.
Select the checkbox, if you want to use the current balloon type.

6.

Select the appropriate option for Items included.

7.



Select the Components checkbox to include all components.



Select the Component accessories checkbox to include all
component accessories.



Select the System accessories checkbox to include all system
accessories.

Click Update.
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44. Updating Balloons
Update balloons of selected symbols or schematic. The update affects both numbering scheme and type of balloons.

1.

Click Update Balloon on the HyDraw® V700 ribbon menu.
Alternatively,
Click

on the HyDraw V700 toolbar.

The Update Balloon dialog box displays.
2.

Select any one of the three options,
 Click the Active page button to select the drawing in the Active
page.

Update Balloon dialog box

 Click the All pages button to select the whole document in the
file.
 Click the Selected symbols button to select the specified
component symbols.
3.

Select the required balloon style or select the current balloon type.

4.

Click OK.
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45. Creating and Inserting Parts List
Create a list of components and accessories for a schematic.
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Insert Parts List
1.

Click Parts
on the HyDraw® V700 ribbon menu.
The Create Parts List dialog box displays.

2.

Select any one of the three options,
 Click the Active page button to select the drawing in the Active page.
 Click the All pages button to select the whole document in the file.
 Click the Selected symbols button to select the specified component
symbols.

3.

Select the items to be included,


Select the Components checkbox to include all components in the
Parts list.



Select the Component accessories checkbox to include all
component accessories in the Parts list.



Select the System accessories checkbox to include all system
accessories in the Parts list.

Create Parts List dialog box

Select the Group identical items checkbox to group all the identical
items in the Parts list.
Group identical items works only for 1A, 1B, 2A, 2B…, 1.1,1.2,2.1,2.2…,
and 1-1,1-2,2-1,2-2… numbering scheme.


4.

Select the required Format.
The default format is applied, if nothing is selected.

5.

Click Next to display the Parts List dialog box.
The Create Parts List dialog box displays detail of the Parts properties.
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6.

Click
or
respectively.

to move the selected item one row up or one row down,

7.

Click

8.

Click Insert to Drawing to insert the Parts list as a separate list in the
drawing.
A message box displays and notifies to specify a rectangular area to
insert the Parts List.

9.

Select a rectangular area in the drawing to insert the Parts list.
The Parts list is inserted into the Visio drawing in a tabular form.

to delete the selected item from the list.

10. To save the Parts list as an Excel sheet,
click Export to Excel.
The Parts List is saved in the Excel format.

Create Parts List dialog box

Create Parts List message box

Parts List
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Customize Parts List Format
1.

Select Options… on the HyDraw® V700 ribbon menu.

2.

Click the Parts List tab.
The Parts List formatting box displays inside the tab.

3.

To rename a selected format,
type the new name in the text box and click

4.

To add a new format,
type the new name in the text box and click

5.

To delete a selected format, click

.

The Configure Columns section enables to edit Display Name,
Alignment, and Width of the columns.
6.

Click Select Columns.
The Select Parts List Columns dialog box displays.

7.

Select the required Model properties or Design requirements
checkbox.

8.

Set the Start Column and the Start Row of the Parts List to be
inserted into the Excel template.

9.

Click OK.
The properties of the selected item are displayed in the Parts List
formatting box in the Configure columns section.

HyDraw Options: Parts List

The same properties are displayed in the tabular form Parts list,
when creating Parts list in the Visio drawing.

Select Parts List Columns dialog box
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46. Creating and Inserting Ports List
Create a list of external ports used in the circuit and insert this list in the drawing. The tabular list exhibits details about the external ports.

Insert Ports List
1.

Click Ports
on the HyDraw® V700 ribbon menu.
The Create Ports List dialog box displays.

2.

Select any one of the three options,
 Click the Active page button to select the drawing in the Active page.
 Click the All pages button to select the whole document in the file.

Create Ports List dialog box

 Click the Selected symbols button to select the specified component
symbols.
3.

Select the Group identical items checkbox to group all identical items in the
Ports list.
Group identical items works only for 1A, 1B, 2A, 2B…, 1.1,1.2,2.1,2.2…, and 11,1-2,2-1,2-2… numbering scheme.

4.

Select the required Format. If no format is selected, then the default format is
applied.

5.

Click Next to display the Ports List dialog box.
The Create Ports List dialog box displays the detail of the port properties.

6.

Click
or
respectively.

7.

Click

8.

Click Insert to Drawing to insert the Ports list as a separate list in the drawing.
A message box notifies to specify a rectangular area to insert the Ports list.

9.

Select a rectangular area in the drawing to insert the Ports list.
The Ports list is inserted into the Visio drawing in a tabular form.
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to move the selected item one row up or one row down,

Create Ports List

to delete the selected port from the list.

Create Ports List message box
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Customize Ports List Format
1.

Select Options… on the HyDraw® V700 ribbon menu.

2.

Click the Ports List tab.
The Ports list formatting box displays inside the tab.

3.

To rename a selected format,
type the new name in the textbox and click

4.

.

To add a new format,
type the new name in the textbox and click

.

5.

To delete a selected format, click
.
The Configure Columns section enables you to edit Display Name,
Alignment,
and Width of the columns.

6.

Click Select Columns.
The Select Ports List columns dialog box displays.

7.

Select the required checkboxes.

8.

Click OK.
The properties of the selected item are displayed in the Ports List
formatting box in the Configure columns section.

Ports List tab

The same properties are displayed in the tabular form Ports list,
when creating the Ports list in the Visio drawing.

Select Ports List columns
VEST, Inc.
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47. Creating and Inserting Net List
Create a list of networks (Net List) of components and external ports in the circuit and insert the Net list in the drawing.
The tabular list exhibits details about the networks.
1.

Click Net on the HyDraw® V700 ribbon menu.
The Create Net List dialog box displays.

2.

Select one of the two options,
 Click the Active page button to select the drawing in the active page.
 Click the Selected symbols and connections button to select specified component
symbols.

3.

Create Net List dialog box

Click OK.
The Create Net List box displays net name with corresponding net items and status.
The Status column shows the accounted nets with
and amended nets with
indicating that the nets are amended and require recreation.
By selecting a net on the Status column, the respective net is highlighted in the Visio drawing.
(If the connection is not correct, red dots appear along the connection points.)

4.

Click Clear Error Flags to rectify a connection.

5.

Click Recreate to return to create the Net list.

6.

Click Export to Excel to save the Net list as an Excel file (.xls/xlsx).

7. Click Insert to Drawing to insert the Net list or Click OK to save the Net list and exit.
Note:
The individual symbols of Slip-Cartridge valve cover and Insert are combined with “&” and
treated as a single entity, when creating the Net list.

Create Net List

Caution:


Do not create more than one connection to the connection points. This may result in an incorrect Net list.



If OK is not pressed after net renaming, the corrections will be lost on recreation, with default net naming style.
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48. Creating and Inserting Solenoid Actuation Chart
Create Solenoid Actuation Chart and insert it in the drawing.
1.

Click Solenoid
on the HyDraw® V700 ribbon menu.
The Solenoid Actuation Chart dialog box displays.

2.

Select one of the three options,


Click the Active page button to select the drawing in the Active page.



Click the All pages button to select the whole document in the file.



Click the Selected symbols button to select the specified component symbols.

3.

Under grouping select the Use Item ID option.

4.

Click Next.
The Solenoid Actuation Chart displays Function, Item ID-Solenoid ID, if applicable.

5.

Click Back to change the selection.

6.

Click the Update

7.

Click

or

8.

Click

to delete the selected port from the list.

9.

Click Export to Excel to save the Solenoid Actuation Chart as an Excel file (.xls/xlsx).

Solenoid Actuation Chart – Selection

button to update the function name.
to move the selected item one row up or one row down, respectively.

Solenoid Actuation Chart – Grid View

10. Click Insert to Drawing to insert the Solenoid Actuation Chart into the drawing.

Solenoid Actuation Chart
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49. Showing/Hiding Port Names
Show or hide port names of the selected symbols in the drawing.

1.

Select the symbol to show or hide the port names.

2.

Click Show
on the HyDraw® V700 ribbon menu.
The port names for the selected symbol are displayed.
Port names displayed

3.

Click Hide
on the HyDraw V700 ribbon menu.
The port names for the selected symbol are hidden.

Port names hidden
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50. Display Settings
Display or hide the property values of the components, external ports, and connections, per the Show/Hide property selection in the schematic drawing.

1.

2.

Click
from the Properties group on the HyDraw®
V700 ribbon menu.
The Display Settings – Selection dialog box displays.
Select any one of the three options,
 Click the Active page button to select the drawing in the Active
page.
 Click the All pages button to select the whole document in the
file.
 Click the Selected symbols button to select the specified
component symbols.

Display Settings

The Display Settings – Property dialog box displays.
3.

Click the appropriate checkbox to select individual properties of
components, external ports, or connections.

4.

Click OK.

Note
The Back option takes you to the previous dialog box.
Components with properties shown and hidden
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51. Purging Price Data
Remove price information from components in the schematic drawing.

1.

Select the components of the schematic for which you want to
remove the price information.

2.

Click Purge Price Data on the HyDraw® V700 ribbon menu.
The components in the schematic are selected automatically.
The Purge Price Data warning message box displays, indicating that
the price data will be removed permanently from the selected
components on the drawing.

3.

Click OK, if you want to continue.
On completion, prompts a message - Price data removed
successfully.

4.

Click OK.

Purge Price Data warning box

Purge Price Data message box
Note
Save the schematic with a different file name and/or location before
removing price information for your convenience and future reference.

VEST, Inc.

HyDraw V700

106

52. Purging Properties
Remove the information of the selected properties from the components, component accessories, and system accessories in the schematic drawing.
1.

Click
from the Properties group, on the HyDraw® V700 ribbon
menu.
The Purge Properties – Selection dialog box appears.

2.

Select any one of the three options,
 Click the Active page button to select the drawing in the Active page.
 Click the All pages button to select the whole document in the file.
 Click the Selected symbols button to select the specified component
symbols.

3.

Select the items to be included,


Select the Components checkbox to include all components for purge
properties.



Select the Component accessories checkbox to include all component
accessories for purge properties.



4.

Select the System accessories checkbox to include all system
accessories
for purge properties.

Warning:
The data once purged is lost forever and cannot be recovered using Visio
Undo command.

Click Next.
The Purge Properties – Property dialog box displays.

Note:
The Back button takes to the previous dialog box.

5.

Click the checkbox to select individual properties
or click Select All properties to remove the data.

6.

Click OK.
The Purge properties progress bar appears and on completion, displays the
message, ‘Selected data removed successfully’.

7.

Click OK.
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Purge Properties completion
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HyDraw Property Manager before purge properties
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HyDraw Property Manager after purge properties
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53. Display Format
Add new display formats to the symbols.
1.

Click

on the HyDraw® V700 ribbon menu.

The Add New Display Format – selection dialog box displays.
2.

3.

Select any one of the three options,

Click the Active page button to select the drawing in the Active
page.


Click the All pages button to select the whole document in the
file.



Click the Selected symbols button to select the specified
component symbols.

Add New Display Format – Selection

Click OK.
The Add New Display Format dialog box displays.

4.

Enter the Name of the display format.

5.

Click
on Property1 section to select the property to display in
required format.
The Select Property dialog box displays.

6.

Select property and click OK.

7.

Enter the prefix and suffix values to be displayed.

8.

Select the Display unit check box to display the units.
Repeat steps 5 to 8 to select more than one and up to three
properties to be displayed in this display format.

9.

Click Add to add a new display format with the selected symbols.
Add New Display Format dialog box

VEST, Inc.
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54. Collating Documents
Save the documents linked to components, component accessories, and system accessories in the user-specified location.

1.

Click Collate Documents
on the HyDraw® V700 ribbon menu.
The Collate Documents dialog box displays.

2.

Select any one of the three options,

Click the Active page button to select the drawing in the Active
page.

3.



Click the All pages button to select the whole document in the file.



Click the Selected symbols button to select the specified
component symbols.

Select the items to be included,

Select the Components checkbox to collate the documents linked
with the components.


Select the Component accessories checkbox to collate the
documents linked with the component accessories.



Select the System accessories checkbox to collate the
documents linked with the system accessories.

4.

Click Next to display the Collate Documents dialog box showing linked
files.
The Collate Documents dialog box displays.

5.

Select the files and click OK to save the documents in the appropriate
folder.
The Browse For Folder dialog box displays.

6.

Collate Documents dialog box

Collate Documents: save files

Select the appropriate folder or click Make New Folder to create a new
folder in the appropriate location to save the documents.
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55. Collating CAD Files
Save the CAD files linked to the component, component accessories, and system accessories in the user-specified location.
1.

Click Collate CAD Files from the Collate option on the HyDraw® V700
ribbon menu.
The Collate CAD Files dialog box displays.

2.

Select any one of the three options,

Click the Active page button to select the drawing in the Active
page.

3.



Click the All pages button to select the whole document in the file.



Click the Selected symbols button to select the specified
component symbols.

Collate CAD Files dialog box

Select the items to be included,

Select the Components checkbox to collate the documents linked
with the components.


Select the Component accessories checkbox to collate the
documents linked with the component accessories.



Select the System accessories checkbox to collate the documents
linked with the system accessories.

4.

Click Next to display the Collate CAD Files dialog box showing linked
files.
The Collate CAD Files dialog box displays.

5.

Select the files and click OK to save the documents in the appropriate
folder.
The Browse For Folder dialog box displays.

6.

Select the appropriate folder or click Make New Folder to create a new
folder in the appropriate location to save the documents.
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56. Manifold Quote
Request a manifold quotation from a registered manifold manufacturer.
1.

2.

Click Manifold Quote from the Manifold Quote option on the
HyDraw® V700 ribbon menu.
The Manifold Quote dialog box displays.
Click the Active page button to select the drawing in the Active
Page. (or)
Click the Selected symbols button to select specified component
symbols.

3.

Click OK to continue.
The Manifold Quote dialog box displays.

4.

Select the manufacturer, material and plating, delivery details, and
the order quantity.

5.

Click Check Manufacturability.
The Check Manufacturability dialog box displays.

Manifold Quote dialog box

Check Manufacturability dialog
box

sign in the Manufacturable column shows that the cavity is
available and

sign shows the cavity is not available.

6.

Click Assign Cavity to assign the cavity, where the cavity is not
available
The Assign cavity dialog box displays.

7.

Click Submit.
When the manifold quote request is submitted a successful message
box displays.

Manifold Quote dialog box

The quotation will be mailed to the respective user mail ID.
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57. Exporting To MDTools
Export a HyDraw® V700 created circuit as an XML, which can be readily opened in MDTools® for designing a manifold.

1.

Click Export To MDTools on the HyDraw V700 ribbon menu.
The Export to MDTools dialog box displays.

2.

Click the Active page button to select the drawing in the Active
page.

4.

Or

5.

Click the Selected symbols and connections button to select the
specified component symbols.

3.

Click OK to continue.
The Save As dialog box displays.

Export to MDTools dialog box

Save the resulting XML file at the desired location.

Export to MDTools sub-menu
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58. Introduction to QuickManifolds
The www.QuickManifolds.com is promoted by VEST, Inc. the leader in
manifold design software. It can automatically create an error free
compact manifold for an input hydraulic schematic drawing.
QuickManifolds® is an online automated manifold design service,
powered by VEST patented AutoRouter™ technology*.
The service is available 24x7 at www.QuickManifolds.com
The process starts with a hydraulic circuit and the software generates a
complete manifold design.
The AutoRouter™ program automatically places all cavities on the
block, creates hydraulic connections between cavities, per the
schematic drawing.
The program also does the required design checking.
Each assignment submitted to QuickManifolds® can take a couple of
seconds to 3 -4 hours to design the manifold.
The time taken depends on the number of cavities, connection
complexity, and the constraints applied.

* US Patent No. 7558713
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59. Go To QuickManifolds.com
You are directed to the www.QuickManifolds.com website.

Click Go to

.on the ribbon menu

The QuickManifolds portal opens:
www.QuickManifolds.com

QuickManifolds.com
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60. Submitting Circuit to QuickManifolds
Submit HyDraw® schematics to QuickManifolds® for automated manifold design.
1.

Click Submit Circuit from the Submit drop-down menu on the
HyDraw V700 ribbon menu.
The QuickManifolds: Login dialog box displays.

QuickManifolds: Login
Submit: Submit Circuit
2.

Enter your user name and password.
The Submit Circuit dialog box displays.

3.

Click the Active Page button to select the entire page. (or)
Click the Selected symbols to submit only the selected components
and ports.
Submit Circuit – Selection dialog box
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The QuickManifolds: Submit Design page loads.
The data and the default values entered into HyDraw® are
automatically read from the QuickManifolds® Web server and
populated into the user interface.
The QuickManifolds: Submit Design page has 4 property tabs:
Geometry, Design, Constraints, and Submit.

Geometry Tab
 The Geometry tab consists of three sections,
Component, External Port, and Orifice.
 The Component section displays ID, Model, Cavity, Outline,
Stamp, and Available status of the cavity.

QuickManifolds: Submit Design- Geometry
 Select the Footprint/Cavity and Click Assign Outline that enables
to redefine the component outline.
For Cavities – Select the Use Spot Face Diameter or Custom
and define the diameter.

Cavity – Assign Outline
VEST, Inc.
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Footprint - Assign Outline : Same as FootprintEnvelope

Footprint - Assign Outline : Available outline

Footprint - Assign Outline : Custom
For Footprint - Select Custom Outline and define
L, W, X and Y as described in the Preview.
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For Footprint - Select the Same as Footprint Envelope or Custom
Outline and define L, W, X and Y as described in the Preview.



Select the Footprint/Cavity and Click Assign Cavity that enables to
reassign the cavity.
By default only the Footprints/cavities with the same number
of ports are displayed.
To view all cavities irrespective of the number of ports of the
Footprints/Cavity, select Show All Cavities.



The External Port section displays ID, Model, Cavity, Outline, Stamp,
and Available status of the cavity.



The Assign Outline option enables to redefine the outline of the ports.



The Assign Cavity option enables to reassign the cavity for the ports.



The Orifice section displays Orifice, Cavity, Outline, Stamp, and
Available status of the cavity.



The Assign Cavity option enables to reassign the cavity for the
orifices.

Assign Cavity
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Design Tab
1.

Configure following settings,
 Design Units
 Mounting Holes
 Design Parameters, such as wall thickness,
component clearance, drill slenderness ratio
 Manifold Material library
 Drill Diameters library
 X-Drill Standard Library

2.

Click Save.

QuickManifolds Submit Design- Design
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3.

Click Advanced Options to set the following:

External Ports:

External Valves:

Cross-pilot:

Misc:

VEST, Inc.
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Constraints Tab
1.

Define the Face constraints of the
Ports and Valves in two different
sections.

2.

Independently set the face
constraints for Cartridge Valves
and Surface Mounted Valves in
the Valves section.

3.

Click Save button to save the
QuickManifolds® data to the
schematic.

Note:
To set the Advanced Constraints, click
the Advanced Options button.

QuickManifolds : Submit Design
Constraints (Ports)
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Advanced Constraints
The Advanced Constraints allow you to
set constraints for external ports and
valves.
Note
Advanced constraints are available only to
External Ports and Valves that are
constrained to a single face.
Specify Location
1.

Select External Port/Valves from the
External Port list or the Valves list.

2.

Specify the X-Distance and Y-Distance of
the selected port from the origin.
You can see the preview of the selected
cavity and its location.

3.

Click Save.

QuickManifolds : Advanced Constraints

Aligning
1.

Select External Port/Valves from the the
External Port list or the Valves list.

2.

Select the External Port/Valve name from
the Align with drop down.

3.

Select the Horizontally or Vertically
option, per requirement

6.

You can see the preview of the selected
cavities and their orientation.

4.

Click Save.

VEST, Inc.
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Submit Tab
1.

Define Title Block Information such as, Title,
Customer, Part No. Drawn, Checked by,
Approved, and Projection Type.
It also displays the block design cost, account
balance, and the available credit.

2.

Click Export to save the QuickManifolds®
Schematic data in the XML format.

3.

Click Save to save the QuickManifolds® data
to the schematic.

4.

Click Submit to submit the design to
QuickManifolds®.
A message displays to state the current block
design cost.

5.

Click OK to continue.
When the circuit is successfully submitted to
QuickManifolds.com,
the Submit Circuit message displays.

6.

Click OK.

Block Design Cost

VEST, Inc.
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61. Checking Design Status
Check the status of the manifold design submitted to QuickManifolds®.

1.

Click Check Design Status from the Submit option on the HyDraw®
V700 ribbon menu.
The QuickManifolds: Login dialog box displays.

Submit: Check Design Status

2.

Enter your user name and password.
The QuickManifolds: Check Design Status dialog box displays.

QuickManifolds: Login

VEST, Inc.
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3.

Provide the Design Jobs detail, such as
Created by, Created period, Part number, and Customer.

4.

Click GO.
The submitted designs are enlisted in the Job Detail grid.

5.

Select the design from the Job Detail section.

6.

Click View Job Details.
The Refresh button repopulates the job detail and status from the
QuickManifolds® server.
The Revision Details grid displays the design details.
The Revise Input button enables resubmitting the design with
constraints change at a very reduced cost i.e only 20% cost of the
initial design.

7.

The Download Files section provides,
 Input file in the XML format
 MDTools® Viewer file
 Design Report in the PDF format
 Drawings of the design in step format

QuickManifolds : Check Design Status
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62. QuickManifolds Viewer
Click the Viewer/MDTools download link.
The QuickManifolds: Download File dialog box
displays.

1.

QuickManifolds: Download File
2.

Select Save File or Open File.

3.

Select OK.

Note


To view the output files, install QuickManifolds®
Viewer available along with the HyDraw®
Installation.



To get further details on working with
QuickManifolds and downloading of the
QuickManifolds User Manual, please visit
www.QuickManifolds.com.

QuickManifolds Viewer opens the Design Output
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63. Purging QuickManifolds Data
Remove the QuickManifolds® information from components in the schematic drawing.

1.

Click Purge
on the QuickManifolds section of the
HyDraw® V700 ribbon menu.
The Purge QuickManifolds Data warning message box displays and
warns that the QuickManifolds data will be removed permanently.

2.

Click OK, if you want to continue.
On completion, prompts a message –
QuickManifolds data removed successfully.

3.

Click OK.

Purge QuickManifolds Data warning message box

CAUTION
Save the schematic with a different file name and/or location before
removing QuickManifolds® information, for your convenience and future
reference.

VEST, Inc.
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64. Saving As DWG
Convert the HyDraw® drawing in Visio into the AutoCAD compatible DWG format.

Saves As DWG drop-down menu
1.

Click the Save As DWG option on the
HyDraw extras drop-down menu.
The Save As DWG dialog box displays.

2.

Click Create DWG to save the file as an
AutoCAD compatible DWG drawing.

3.

The Save Drawing As dialog box displays.

4.

Specify the desired location and file name
for the drawing.

5.

Click Save to save the file.

Note
The drawing closes and reopens into DGW
after exporting.
Therefore, you must save the drawing before
exporting.

Save As DWG
VEST, Inc.
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The Fill option is switched off by default in
AutoCAD.

Switch the Fill option to ON in AutoCAD to
display the filled regions in the drawing.
1.

If AutoCAD is open, then insert the
drawing exported from HyDraw®.

2.

Enter FILL at the AutoCAD command
prompt and press Enter.

3.

Enter ON and press Enter.

The Schematic saved in DWG format

VEST, Inc.
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Regenerate the drawing to display filled
regions.
1.

Enter REGEN at the AutoCAD command
prompt
and press Enter.

2.

Save and close the drawing.

Known Limitations:


The exported drawing appears in black.



Envelope line below an external port
symbol is not automatically trimmed.



If you have created symbols by importing
an AutoCAD drawing,
then the filled regions (e.g arrow heads)
created using polyline or solid hatch in
AutoCAD will appear unfilled in the
exported drawing.



Text background in the Visio drawing
cannot be converted to DWG.

The Schematic displaying filled regions in the drawing file
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65. Unit Converter
Convert the value of any unit category from one selected unit to another selected unit.

1.

Click Unit Converter from the Calculator
option on the HyDraw® V700 ribbon menu.

The Unit Converter dialog box displays.
2.

Select a unit category.

3.

Select the units system in From and To
Unit list box, per requirement.

4.

Specify the unit value in From Value text
box.

The converted units value appears in the To
Value text box, in the required unit system.
5.

Click
to copy the To value to the
clipboard.

Unit Converter
HyDraw Unit Converter
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66. HyDraw V700 Installation
The HyDraw® installation program installs HyDraw V700 on your computer system.

System Requirements
 Windows® 7 / 8 / 8.1
 Microsoft® .NET Framework version 4.0 or higher
 Adobe Reader 6.0 or higher
 Microsoft Visio® 2010 (32/64 bit)/ Microsoft Visio 2013 (32/64 bit) SP1
 Microsoft Excel 2007 or higher*
 Other system requirements, per Visio®
* Required only for exporting HyDraw Data from Visio and importing data into HyDraw Library

VEST, Inc.
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Software Installation
1.

Insert the HyDraw® V700 DVD into the DVD drive.
If Auto Run is not set, then:

On the Start menu, click Run.

Browse to the HyDrawV700Start.exe program on the DVD
drive.

Select HyDrawV700Start.exe, and click Open.

Click OK.
The HyDraw V700 startup screen displays.

Click Install on this computer.
The HyDraw V700 Installshield Wizard dialog displays.
The installation program starts and guides you through the
installation process.

2.

Install HyDraw Library Manager to install the Library and its
manager.
The installation program starts and guides you through the
installation process.

3.

Install latest QuickManifolds® Viewer from the following link:http://www.vestusa.com/download/QuickManifoldsViewerSetup.zip

4.

View the HyDraw V700 Read Me and User Manual from the
provided links, if required.
HyDraw V700 startup screen

5.

Once complete, click Exit in HyDraw V700 dialog box and
restart your computer for the changes to take effect.
HyDraw V700 and HyDraw Library Manager are installed on the
system and HyDraw V700 is displayed in the Windows Start >
Program menu.
A HyDraw V700 shortcut icon is created on the desktop.
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67. Submitting Authorization Request
1.

Double click the HyDraw ® V700 desktop icon.
The HyDraw V700 Authorization dialog box displays.

2.

Alternatively select,
Start
> All Programs
> VEST
> HyDraw V700
> HyDraw License
Manager
The HyDraw License
Manager
dialog box displays.

3.

Click the Activate
button.
The HyDraw V700 Authorization
dialog box displays.

.
4.

Select Authorize HyDraw V700 or Try HyDraw V700 for 30 days trial
period.

5.

Click Next.

5.

Select Generate activation
request.

6. Click Next.

VEST, Inc.

7.

Enter the Serial Number provided
when you purchased the software.

8.

Click Next.

9.

Enter your contact details.

10. Click Create Request
Authorization request is generated
and prompts to save in an xml file.

HyDraw V700

11. Attach the request file to an email
and send it to
support@VESTusa.com.
12. Click Close.
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68. Authorizing HyDraw V700
1.

Double click the HyDraw ® V700 desktop icon.
If the program has not yet been authorized, the
License Server Product Authorization dialog box
displays.

2.

Select Authorize HyDraw V700.

3.

Click Next.

Alternatively select,
Start
> All Programs
> VEST
> HyDraw V700
> HyDraw License Manager
The HyDraw License Manager
dialog box displays.
4.

Click the Activate button.
The HyDraw V700 Authorization dialog box
displays.

VEST, Inc.

5.

Select Open authorization file.

6.

Click Next.

9.

Click Close.
The dialog box closes and HyDraw License is
successfully activated.

10. Check the License Details from the HyDraw
License Manager.

7.
8.

Click Browse and select the saved
Authorization Code xml file.
Click Activate.

HyDraw V700
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69. Transferring Standalone License
5.

The fully activated Network License has the Transfer button available to return the software to VEST for deactivation of the software on the current machine
and reactivate it on a different machine.

Submit Transfer Request

1. Select,
Start
> All Programs
> VEST
> HyDraw V700
> HyDraw License Manager

A warning message appears indicating the
license will be disabled.

The HyDraw License Manager dialog box
displays.

8.

Authorization request is generated and
prompts to save the xml file.

7. 3. Select Generate transfer request.
4. Click Next.

9.
6.

2. Click the Transfer button.
The HyDraw V700 Authorization dialog box
displays.

VEST, Inc.

Click Yes to continue or No to skip the
transfer.

Attach the request file to an email and send
it to support@VESTusa.com.

10. Click Close.
6.
7.

Change your contact details, if required.
Click Create Request.

HyDraw V700

Note: The transfer process will be completed
only, when you activate the authorization file
received from VEST.
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Authorize Transfer Request
1.

Select,
Start
> All Programs
> VEST
> HyDraw V700
> HyDraw License Manager
The HyDraw License Manager dialog box
displays.

4.
5.

Select Open authorization file.
Click Next.

8.

Click Close.
The dialog box closes and HyDraw License is
successfully transfered.

2.

Click the Transfer button.
The HyDraw V700 Authorization dialog box
displays.

VEST, Inc.

6.

Browse and select the saved Authorization
Code .xml file.

7.

Click Activate.

HyDraw V700
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70. Using and Borrowing Network License
The HyDraw client machines can use a network license available from the HyDraw License server Manager.

Using Network License
1. Select,
Start
> All Programs
> VEST
> HyDraw V700
> HyDraw License Manager

Borrowing Network License
6.

1. Select the License Borrowing tab.

7.

Select the Borrow until date.

The HyDraw License Manager dialog box displays.

8.
9.
3.

2. Select the Network license option.

4.

3. Set the License Server Name/IP Address and Port number.

5.

4. Click Apply.

VEST, Inc.

Click the Borrow button.
The Borrowed license details are displayed in the grid.
4. Click OK to exit.

Return Network License
1. The license can be returned by clicking the Return button.
2. Click OK to exit.

HyDraw V700
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71. Library Network Configuration
HyDraw® V700 can access data from a HyDraw library on a local network by using the Corporate Library option.
This enables all designers in an organization to work efficiently by sharing a common data resource.
For details on installing the HyDraw Library, refer the Library Manager User Manual.

1.

Click the Library Path tab.
The Library Path tab page displays.

2.

Select the Local Library option.

3.

Select the Enable modification check box to modify library.

4.

Click Browse… and vavigate to the folder where the HyDraw®
Library data is stored.
The Symbols and Sub-subsystems path are automatically set if the
Data, Symbols and Sub-systems folders are located at the same path.

5.

Repeat the above steps for each of the specified HyDraw library
path, if required.

6.

Select the Corporate Library option to configure the second library
path of your common Network library and repeat steps 3 to 6, if
required.

7.

Click OK.
All the HyDraw library paths are configured.

Data Path tab page
Note
All data paths shown are default.
You can configure to common network data paths.

VEST, Inc.
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72. Setup Online Services (FPT & QM)
Internet Settings for accessing FluidPowerTools.com and QuickManifolds.com

1. Automatically detect settings
If your computer is connected to the Internet through a direct LAN
connection, then select the Automatically detect settings option.

Connection Settings – Direct Connection

VEST, Inc.
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2 Configure LAN Settings
1.

Open Internet Explorer.

2.

Select Tools
> Internet Options

3.

Select LAN settings from the Connections tab.

4.

Configure the LAN settings.

Note
For direct connection, you should deselect the Use a proxy server for
your LAN option in the LAN Settings dialog box.

IE browser settings

VEST, Inc.
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3 Proxy Connection
If your computer is connected to the Internet
through a web proxy server,
then select Use proxy server.
Configure the proxy settings.
1.

Enter the Address.

2.

Enter the Port number.

3.

Enter authentication details, if required.
You may refer to the settings that may be
already defined in
your web browser.
Connection Settings – Proxy Settings

Note




If an automatic configuration script is used in the
browser for proxy,
then use the Proxy server settings from the LAN
Settings dialog box in the browser to configure
your Proxy Connection Settings.

Internet Options

If you do not find proxy server details in the
browser,
then contact your system administrator.

VEST, Inc.
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73. Configure ERPServiceConfiguration.xml
You can configure the XML Code for each property in ERPServiceConfiguration.xml.
The sample ERPServiceConfiguration.xml file is
available at the “ERP” folder in the HyDraw Setup.
Configure the column name of the XML code for
each property, per your ERP data Excel Sheet &
InternalName and DisplayName in Properties table
of ComponentData.mdb database by default
available at “C:\VEST\HyDraw Library 2013\Data\”.
Each property has three attributes
1. ColumnName is the corresponding column as
defined in the Excel sheet without any spaces.
(Configurable)
2. InternalName is the variable name as in
Properties table without any spaces. (Not
Configurable)
3. DisplayName is the variable name as in
Properties table. (Not Configurable)
Note:
ERPServiceConfiguration.xml and the ERP
Excel sheet must be at the same location.
All the columns in the ERP Data in Excel, must
be in Text Format.
Special characters are not supported in
ERPServiceConfiguration.xml

ERPServiceConfiguration.xml, Properties Table & Sample ERP Data in Excel Format
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